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Creating Accessible PowerPoint Documents 

Overview 

This tutorial is written for Microsoft Office PowerPoint 2007 for Windows.  Microsoft 

PowerPoint is an application for creating slide presentations.  Presentations created with 

PowerPoint may contain text, graphics, audio, video, or other dynamic features. Due to 

the visual nature of PowerPoint documents, it is important to carefully plan the 

organization, layouts, text and visual content of your slide presentation to ensure your 

document is accessible. 

Learning Objectives 

Upon completion of this tutorial, you should be able to: 

1. Define what makes a PowerPoint document accessible 

2. Create a structure for PowerPoint presentation by using Slide Layouts and Outline 

pane  

3. Add descriptive alternative text or caption to explain graphics, images, charts, or 

any non-text information 

4. Use Notes pane to explain complex images, tables, charts, audio or visual files 

5. Include meaningful name, hyperlink, and url for websites 

6. Create chart or table within PowerPoint or include source file 

7. Print in various formats  

8. Convert PowerPoint to a PDF document  

9. Locate resources to convert PowerPoint to other accessible format 

Prerequisites 

Individuals using this tutorial should have basic computer skills and the ability to work in 

the Windows operating system. 

What is Accessibility? 

Accessibility in terms of electronic documents here refers to facilitating the use of 

technology for people with disabilities. Providing equivalent access to online electronic 

documents for all faculty, staff and students across the CSU system is articulated in 

Executive Order 926 at http://www.calstate.edu/eo/EO-926.html.  This Executive Order 

formalizes and documents all CSU’s responsibilities to comply with the requirements of 

Section 508 of the federal Rehabilitation Act. To learn more about accessibility 

requirements for the CSU, visit About the Accessible Technology Initiative  website at 

http://www.calstate.edu/accessibility/. 

The focus of this tutorial is to create documents that are accessible to individuals with a 

visual impairment and to those who require the use of an assistive technology such as, a 

text reader, to navigate and read documents. Deaf and hard-of-hearing students benefit 

from captioned audio and video in a presentation. Students with physical disabilities, 

http://www.calstate.edu/eo/EO-926.html
http://www.calstate.edu/accessibility


Center for Faculty Development and Support Page 4 of 16 

 

learning disabilities, and English language learners may also benefit from the formatting 

features of an accessible document.  

What Makes a PowerPoint Document Accessible? 

Accessible PowerPoint presentations are readable by all students regardless of apparent 

disability. Specific accessibility remediation for assistive technology allows text reader 

software, used by people with visual impairments, to read documents on the screen with 

the read out loud feature.  Captioned audio accompanying the PowerPoint allows deaf or 

hard-of-hearing people to understand the presentation. Accessible PowerPoint documents 

include the following considerations: 

Logistics 

 Presentations are prepared ahead of time and rehearsed 

 Have an electronic copy posted on a course website 

Text 

 Ensure all texts to be read are displayed on Outline pane 

 Add alternative text or caption to describe all images or graphics  

 Use Notes pane to explain complex images, tables, charts, and audio or visual 

files 

 Include meaningful name, hyperlink, and url for websites 

 Use font size larger than 30 points 

 Contain less than seven points per slide 

 Avoid flashing or blinking text, objects, or other elements  

 Provide a non-animated version of presentation if animation is used 

Layout 

 Use slide layouts to format and organize content 

 Create tables, charts and graphs within PowerPoint.  Or, link to source document 

 Use good color contrast. Some users cannot perceive certain colors such as, green 

and red. 

 Use a style such as, bold or capitalization to emphasize text in a document instead 

of relying on color  
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Overview of a PowerPoint Normal Default View 

The major elements of a normal default view include: 

1. Slide and Outline area on the left 

2. Content stage area in the center and right 

3. Notes pane area below the content stage area 

4. View button below Notes pane for Normal, Slide Sorter, or Slide Show view 

 

 

Figure 1. A PowerPoint normal default view 

The Outline Pane 

Click the Outline tab in the Slide and Outline area to display the outline pane.  Only text 

displayed on the outline pane will be read by a text-to-speech reader.  Ensure each slide 

has a slide title.  The slide title serves as the structure in navigating and understanding the 

logical flow of the slide presentation.  
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Slide Layouts 

To create a slide presentation, select a layout from the nine built-in PowerPoint slide 

layouts.  These built-in slide layouts will standardize formatting and ensure the content is 

properly added to the outline pane.  Slide layouts help define the sequence of titles, 

subtitles, content texts, and objects in the entire slide presentation.  Avoid using the blank 

slide layout as it does not contain any placeholder for texts, hence will not be read by 

text-to-speech reader. 

Follow the steps below to select your desirable slide layout: 

1. On the Home tab, in the Slides group, click the down arrow on the lower right 

corner of the New Slide icon and nine built-in slide layouts of the Office Theme 

will appear. 

 

     

Figure 2.  New Slide icon with a down arrow on the lower right corner highlighted in Slides group 

on the Home tab 

2. From the Office Theme of nine built-in slide layouts, select title slide or an 

appropriate layout to start building your slide presentation. 

 

 

 
Figure 3.  Office Theme drop down box with nine built-in slide layouts highlighted  
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Caption or Alternative Texts for Images or Graphics 

Text-to-speech software reads texts only and will skip any graphics, images, clip art, 

charts, objects, etc. Add alternative textual descriptions or caption to explain your visual 

images so that the text-to-speech reader will convey the content information of your 

visual images. Caption is visible text usually added below or next to an image. 

Alternative text (alt text) is invisible text but will be read by the text-to-speech reader to 

explain the image. 

Single Image 
Follow steps below to add alternative texts for a single image. 

1. Right-click the image, picture, chart of the graphic, or any non-text object, 

then click Size and Position.  

 Figure 4.  A pop-up box with Size and Position highlighted 

2. In the Size and Position window, click the Alt Text tab and enter your 

descriptive text in the Alternative text box. 

 

Figure 5.  Size and Position window with descriptive texts in the Alternative text box 

javascript:AppendPopup(this,'ofdefObject_8_8')
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Grouped Images 
Sometimes you may include several images to illustrate one key point. If so, consider 

grouping the images together as one big image and enter descriptive texts for all images 

at one time.  Follow steps below to group images: 

3. Hold down Shift key and click on each images 

 

Figure 6.  Screen shot of 5 images selected  

4. Right click the grouped image and select Group under Group in the pop-up box.  

 

Figure 7.  A pop-up box with Group selected under Group feature 

5. Repeat steps 1 and 2 to enter alternative text for this grouped image. 

    

Figure 8.  Two screen shots with Size and Position highlighted on the left and on 

the right is the Size and Position window with descriptive texts entered inside the 

Alternative text box 
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Website Hyperlinks 

When websites are referenced in a PowerPoint document, ensure a meaningful name for 

the website, hyperlink, and url are included.  Screen reading software is able to process 

and display all hyperlinks into an index list and read them out loud to the users.  To 

provide and hyperlink the name of the website will enhance the readability so that a list 

of web sites rather than a list of long url or non-descriptive words such as, “Click here” 

will be read.  Follow steps below to insert hyperlinks. 

1. Select the name of the website such as,  

2. Right click the highlighted texts and select Hyperlink…in the pop-up box. 

  

Figure 9. A pop-up box with Hyperlink… selected 

3. Enter the url in Address box at the bottom of the Insert Hyperlink window and 

click OK. 

  

Figure 10.  Insert Hyperlink window with url entered in the Address box 
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Using Notes Pane 

If the image is a complex table or chart, use Notes pane to add long descriptions. It may 

also be used for speaker notes or for captions of audio or video files that are added to the 

slide presentation. Notes pane is located below the slide content stage area. 

Entering Text in Notes Pane 
Click to add notes in the Notes pane.  If you need more space to enter your text, move 

your cursor between the Notes Pane and slide content stage area until your cursor turns 

into an icon with an up and down arrow.  Click and drag this icon upward to resize your 

Notes pane. 

  

Figure 11.  A complex chart slide with Notes pane highlighted 

Text in the Notes pane will not be read by a text reader.  Attach the notes page of those 

pertinent slides as a separate document to your PowerPoint slide presentation.  Follow 

steps in the next section to save your notes as a separate document. 
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Saving Notes as a Separate Document 
1. Select Publish from Office button drop down menu.   

2. Select Create Handouts in Microsoft Office Word in the pop-up box.  

 

  

Figure 12.  Office button drop down menu with Create Handouts in Microsoft Office Word 

highlighted 

3. In the Send to Microsoft Office Word window select your desirable page layout 

in Microsoft Office Word by clicking the appropriate radio button such as Notes 

next to slides.  

 

Figure 13. Send to Microsoft Office Word window with Notes next to slides radio button selected 

4. Click OK to save your Notes as a separate Word file.  Attach this separate Notes 

document to your slide presentation.  
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 Tables or Charts 

Tables and charts are useful for displaying data in an organized manner. Relationships 

between data can be easily and clearly shown in a visual format by referring to the 

column and row headings or X and Y coordinates.  Simple tables are read by screen 

readers when column and row headers are clearly defined.  However, a screen reader 

cannot associate cells with the row and column headers. Including the header row in a 

table will clarify the tabular data for all students as well as for the visually impaired.  If 

the table spans multiple pages, ensure the header row is repeated on each slide. 

There are two methods to create tables or charts in PowerPoint: a) Create tables and 

charts within PowerPoint. They can be read more easily by a text reader than those 

imported from Word or Excel. b) Import the data from Word or Excel and attach the 

source document.  

Insert a Table 

1. Click on the Table icon  on an appropriate slide layout. 

2. Determine the appropriate column(s) and row(s) from the Insert Table window 

and click OK.     

Figure 14.  Insert Table window 

Or, 

3. Open the source document and copy original table data from Word document. 

4. Under the Insert menu select Table…  An Insert Table window will display. 

 

Figure 15.  Insert menu with Table selected 

5. Determine the appropriate column(s) and row(s) from the Insert Table window 

and click OK. 

6. Paste the original data onto this new table and attach the source document. 
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Insert a Chart 

1. Click on the Chart icon on an appropriate slide layout and an Insert Chart 

window will be displayed. 

 

Figure 16.  Insert Chart window with Template panel highlighted 

2. Click on a Template such as, Column, Line, Pie, etc., on the left panel to select 

your desired chart type.   

3. Double click on your desired chart selection.  A new Excel spreadsheet will open 

with a sample of staging data on a spreadsheet and a sample of staging chart will 

open on your PowerPoint slide.  

 

Figure 17.   Sample staging Excel spreadsheet data on the left and sample staging PowerPoint 

slide chart on the right 

4. Modify the data on the spreadsheet to reflect your data. 

Or, 

5. Repeat the above steps 1 through 3 

6. Copy the source data from your original Excel spreadsheet and paste the data onto 

the new Excel spreadsheet.  Follow instructions to resize chart data range if 

necessary to reflect your source data correctly. 

Text reader cannot read the context information for the table or chart data. Provide an 

explanation of your slide content by using Notes Pane.  Reference and attach this notes 

page as a separate document to the slide presentation.  See Notes Pane section to review 

how to save Notes page as a separate document.   
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Printing and PDF Document 

The Print feature in PowerPoint is very useful.  It allows you printing slides, handouts, 

notes, outline, and converting slides into PDF documents.  Follow steps below to perform 

your desirable function. Attach Notes or Outline document as a separate document to 

enhance the accessibility of your PowerPoint slides. 

Print Slides, Handouts, Notes, and Outline 
1. Under Office button, select Print to display Print window. 

 

Figure 18.  Office button with Print selected 

2. Under the Print What drop down box in the Print window, click the down arrow 

to display the available options. Make your appropriate selection from the drop 

down box such as, Slides, Handouts, Notes pages, or Outline View and click OK. 

 

 

Figure 19.  A Print window with all available Print What options listed 
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Converting to PDF Document  
 

To convert your PowerPoint into a PDF document, follow steps below. 

1. From Office Button, select Save As and Adobe PDF option. 

 

Figure 20. Office button drop down menu with Save As and Adobe PDF selected 

2. From the Save As window, enter document name in the File name box. 

 

  

Figure 21.  Save As window with document name entered in the File name box and PDF selected 

from the Save as type drop-down menu 

3. From the Save as type drop down menu, select PDF(*.pdf) and click Save. 
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Resources  

In additional to the above requirements, there are additional methods of making 

PowerPoint slides accessible as follows: 

Online Resources 

 Eric Meyer S5 slide show conversion tool at http://meyerweb.com/eric/tools/s5/ 

 Convert PowerPoint to HTML by using Web Publishing Wizard at 

http://virtual508.com/ 

 Lecshare is another tool to convert PowerPoint to HTML page.  Visit Lecshare 

website at http://virtual508.com/ for more information. 

California State University (CSU) Online Resources 

 CSU Accessibility Technology Initiative at http://calstate.edu/accessibility/ 

 Professional Development for Accessibility Technology at 

http://teachingcommons.cdl.edu/access/ 

San Jose State University Online Resources 

 Center for Faculty of Development at http://www.sjsu.edu/cfd/accessibility/ 

 

http://meyerweb.com/eric/tools/s5/
http://virtual508.com/
http://lecshare.com/
http://lecshare.com/
http://calstate.edu/accessibility/
http://teachingcommons.cdl.edu/access/
http://www.sjsu.edu/cfd/accessibility/

